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LAUSD Job Aid for Microsoft PowerPoint  
 

Microsoft (MS) PowerPoint (PPT) allows users to create presentation slides, 
flyers, infographics and more. We will share how PPT can create appealing 
and fancy designs and templates all while preserving the accessible 
structure. It is important to keep digital accessibility in mind when creating 
and using any processing tool. 

According to Section 508 of the Rehabilitation Act of 1973, all federal agencies 
are required by law to make electronic documents (including all digital 
content) accessible for people with disabilities. Individuals with disabilities 
may request for digital content be provided in an alternate format which 
provides effective communication. Additionally, students, District employees 
and visitors who have disabilities can request reasonable accommodations 
to access digital content. All District employees are obligated by the 
Americans with Disabilities Act (ADA) to follow the Web Content Accessibility 
Guidelines (WCAG 2.0 Level AA; and WCAG 2.1 Level AA by April 24, 2026. 

The District is committed to providing program accessibility and inclusion for 
people with disabilities. By providing effective communication, Ethics and 
Compliance Monitoring (ECM) Legal Services Team fosters the maxim that 
“Compliance ensures that students have the necessary tools to succeed.”  

The purpose of this job aid is to share best practices for creating accessible 
PowerPoint presentations. Before creating and sharing PowerPoint files, please 
check that you have implemented the following accessibility best practices.  

How to apply Accessibility to PPT? 
Accessibility should be a forethought when creating your PPT slides. 
Fortunately, all MS Office applications have a built-in Accessibility Checker.  

Step 1: Go to the Review tab and select the Check Accessibility feature: 

https://www.w3.org/WAI/standards-guidelines/wcag/
https://www.w3.org/WAI/standards-guidelines/wcag/
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
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Step 2: Select  Check Accessibility to open the Accessibility pane on the 

right.  

  

Step 3: In the Accessibility pane, review and address the findings under 
Inspection Results. The accessibility checker will alert you to address any 
accessibility errors and warnings. As you create content, the accessibility 
checker will scan your content for the accessibility structure. This tool provides 
additional information on why the error should be fixed and step-by-step 
instructions on how to improve the accessibility of your electronic documents.  
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The accessibility checker will always warn you to manually check the Reading 
Order and Color Contrast. Sometimes the accessibility will detect hard to read 
text, but you should use an evaluation tool, such as a Color Contrast Analyser 
(CCA) to confirm the color ratio passes and meets WCAG 2.0 Level AA 
Guidelines.  

Applying these best practices and making sure to use the accessibility 
checker will guide you in designing accessible PowerPoints. Remember to use 

the accessibility checker along the way and manually check the reading 
order by using a screen reader. 

Blind or low vision individuals use assistive technology such as screen 
readers, magnifiers, braille keyboards, dictation software and more to access 
digital content. These assistive technology devices and services provide 

https://www.lausd.org/cms/lib/CA01000043/Centricity/Domain/1220/ATLL%20Brochure%20Seven%20Locations%20TK%208-28-17.pdf
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independence and privacy for individuals with disabilities and offer inclusive 
learning. Applying these best practices to your PowerPoints will reduce 
accessibility barriers for everyone!  

Best Practices for Creating Accessible Microsoft PowerPoints 

Reading Order (Navigation) 
When creating digital content, designers should check that the slides have an 
accessible reading order (including proper heading levels, list items, tables, 
etc.). Learn more about Creating slides with an Accessible Reading Order. 
Avoid manually creating bullet points, numbered lists, and tables as they will 
not have the accessibility structure and screen readers will not effectively 
navigate the content. Instead, go to the Home tab and select the Arrange 
icon:  

 

Then select the “Selection Pane” to edit the contents reading order. The 
reading order in PPT reads from bottom-to-top, however it will convert to read 
the text left-to-right and top-to-bottom if converted to PDF. Use the File tab 
and select “Save As” to preserve the accessible structure of your content. It is 
important to manually check the reading order structure before saving to 

confirm the screen reader is following the content accurately.  

https://support.microsoft.com/en-us/office/video-create-slides-with-an-accessible-reading-order-794fc5da-f686-464d-8c29-1c6ab8515465
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For images and elements that are solely used for visual esthetics, you will 
need to check “Mark as decorative” in the alt text menu. People using screen 
readers will be informed by the screen reader that the image is decorative, 
which lets them know they are not missing valuable information related to the 
visuals. All non-informational graphics can be moved to the bottom of the 
selection pane to help organize the reading order. If the image description 
(alt text) is not provided or the picture isn’t “marked as decorative”, then your 
PPT will not pass the accessibility checker.   

Slide Master  
It is recommended to create a Slide Master if you want to create a custom 

theme or various slide formats. To create a theme using the Slide, go to the 
View tab and select Slide Master: 
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The main slide will be used to set background elements on all other slides, but 
you can create other slide layouts to customize various slide formats.  

Font 
Use fonts that are easier to read for individuals with vision impairments. 
Ensure your font size is 12 points or larger. Avoid the use of all capital letters, 
excessive italics or underline.     

 

Avoid using fancy fonts with curves or extensions at the end, also known as 
Serif fonts, because these are harder to read and difficult for the screen 
reader to recognize. Instead, you should use the District’s branding fonts 
(Larsseit, Poppins, and Lato) or a San Serif font like Arial, Calibri or Verdana.  

Bullets, Lists and Numbering 
Most slide formats will include a textbox and additional textbox for listing 
items (such as bullet points or number items). If the slide you select does not 
include additional text formatting options, such as listing and numbers, you 
will need to go to the Home tab and select from the Paragraph section from 
the built-in listing formats. Avoid manually creating bullets or number lists 
because the screen reader will not associate the manual insertion and will 
ignore this formatting (Ex. If you have 10 list items the screen reader will read 
“List of ten” and proceed with saying “bullet 1 of 10 [content]… bullet 2 of 10” 
and so on). If you want to include other variations of slides in your 
presentation, you can edit the other slide formats. For additional information, 
read more about What is a slide master? 

https://www.lausd.org/branddownloads
https://support.microsoft.com/en-us/office/what-is-a-slide-master-b9abb2a0-7aef-4257-a14e-4329c904da54
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Note: All slides must have a Title (heading) to be accessible. Do not use blank 
slides that do not include the “Title” textbox. 

Images Descriptions (Alt Text) 
A description added to images is called Alternative Text or “alt text”. It 
provides inclusion for low vision or blind individuals using assistive technology 
such as a screen reader. For images that do not convey important meaning 
or messages, you can select “mark as decorative” under the alt text 
description box. If you use images with embedded text, make sure to include 
the exact text within your image description. As an example, we’ve provided 
an image below that shows the front cover of the book titled, “Haben: The 
Deafblind Woman Who Conquered Harvard Law” and it shows a side profile of 
the author Haben Girma wearing a blue garment with a red background.   

Additionally, the image illustrates how you can add alt text to your images; by 
right clicking on the image and selecting Edit Alt Text. You can add a brief 
image description (1-2 sentences or 200 characters or less) including proper 

punctations.  

Note: If using acronyms, it is best to spell out the full name first and use 
spacing or periods in between each letter of the acronym to guarantee that 
the screen reader pronounces the term correctly; for example, Los Angeles 
Unified School District should be spelled out first then use spacing or periods 
to separate each character (e.g. L A U S D or L.A.U.S.D.), or you can use the 
term “the District” which is commonly used in place of spelling out the full 
name of the school district. 

 

https://www.canva.com/help/using-alt-text/
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There is an auto-generated alt text feature that can be edited to enhance the 
image description, but we recommend overriding the auto-generated alt text 
and including a meaningful description because the auto-generated alt text 
may be incorrect or vague as shown in the above example (Alt text reads: “A 
profile of a person.”). Because the title is embedded within this image and the 
screen reader is unable to decode the burnt in text, the text and a description 
recognizing the author would be adequate for adding alt text to this image.  

Content creators are best at describing images. Adding images/graphics to 
your PowerPoint can be fun and beneficial for sharing relevant and essential 
information. Make sure to add alt text so that everyone has access to your 
content. 

Captions (Subtitles) 
Want to record your presentation and share it with others?  By recording the 
presentation, it now becomes a video which requires closed captioning to be 
added; additionally, providing a written transcript is recommended. Microsoft 
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PPT allows you to transcribe your words as you present for real-time auto 
captioning. However, it is important to always do a manual check of the 
closed captions and make any necessary grammar corrections. You can 
choose the language you want to speak in, and the auto captions will add 
subtitles in the language you select. Read more on how to enable captions 
and subtitles when presenting. 

Color contrast 
Make sure there is enough color contrast is used between the foreground 
(text) color and background color. Test the colors used in your content with 
the Color Contrast Analyser (CCA). WCAG 2.0 Level AA requires a color 
contrast ratio of at least 4.5:1 for normal text (12pt.) and 3:1 for large text (14pt 
or larger) fonts. It is best to check your color using the color picker or enter the 
colors in RGB hexadecimal format prior to exporting your design(s).  

 

Feedback will be presented for all three required contrast calculations: link to 
body text, link to background and body text to background. Ensure your 
communication has high contrast between text and background colors. Avoid 
solely replying on color to convey information and ensure that there is a 
readable marker for color-blind users. Test results will show if the contrast 
passed or failed. 

Tables 
Avoid drawing or manually creating tables or lists. The screen reader will not 
associate the list items or tables rows with the table heading structure. Using 
the built in Table, List or Number features in PPT will guarantee that the screen 
reader will announce the correct information as shown on the slide; this 

https://support.microsoft.com/en-us/office/present-with-real-time-automatic-captions-or-subtitles-in-powerpoint-68d20e49-aec3-456a-939d-34a79e8ddd5f
https://support.microsoft.com/en-us/office/present-with-real-time-automatic-captions-or-subtitles-in-powerpoint-68d20e49-aec3-456a-939d-34a79e8ddd5f
https://webaim.org/resources/contrastchecker/


 

10 
 

concept is known as the “Header Cell Association”. Once you use the Insert 
tab to create a table, remember to apply the Header Row which is located in 
the Table Design tab.  

 

• Simple Data Tables: Information in a cell requires information from a 
row and or column header to describe the cell’s content. 

• Complex Data Table: use information in a row and column to describe 
the cell’s content, however this table includes multilevel headings or 
merged or split cells. 
 

Note: Multilevel headings and merged cells are inaccessible, so avoid using 
complex data tables. Separating the tables or providing them outside of a 
table structure is advised.  

Descriptive Links 
Phrases such as “click here” or “read more” are not inclusive for blind or low 
vision users. Use descriptive links to inform your audience where the link will 
direct them to; most links are random characters with no information on the 
destination of the website.  

Here is how to create descriptive links (hyperlinks): 

Step 1: Write a meaningful and descriptive phrase or title that relates to the 
website you are sharing (e.g. Make your long URLs short and meaningful). 

Step 2: Highlight the text you wish to create a link for, then right-click on the 
highlighted text and select the Links option.  

https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_tableswin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_tableswin
https://www.ttuhsc.edu/disability/documents/ADA_Shorter_URLs.pdf


 

11 
 

Step 3: Leave the Text to display as is, unless you would like to change the 
phrase that will appear as linked. Add the URL link to the Address section and 
select “OK” to save your hyperlink. You can also go to the Insert tab and select 
the Links option to create a hyperlink.    

 
Note: Do not reuse the same phrases for hyperlinks in a document or 
webpage because screen reader users navigating the “List all links” menu will 
be confused if the links go to different locations but have the same link name. 

Additionally, it is common practice for most hyperlinks to use underline and 
blue font color (text). Avoid underlining other text such as titles, as this may 
cause confusion for a screen reader to correctly distinguish between regular 
text and links. Do not place links within alt text because the alt text is only 
accessible for screen reader users, and it will read the characters individually. 

Use link shorteners rather than long URLs which are meaningless for people, 
especially screen reader users. To create short links, go to tinyURL or bitly.com, 
which are free link shortener websites. Add the long URL and customize your 
link adding meaningful language that will inform the user of the website 
destination. 

https://tinyurl.com/
https://bitly.com/
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QR Codes 
Often, QR Codes are added to PowerPoint slides to reference resources or 
other webpages. Be sure to add alt text to your QR Code so screen reader 
users are aware of what the QR Code is referencing. Additionally, you would 
be required to add a short link for individuals who may not use mobile devices 
or have access to take a picture of the QR Code. 

Mobile Display 
Some people may access your content via mobile devices. It is 

recommended to always check your content using a tablet or cellphone to 
ensure the content is readable. 
 
Remember, creating accessible content benefits everyone! Make sure you 
apply these best practices to your PowerPoints. If you have additional 
questions or need ADA Technical Support, please contact the Office of ADA 
Compliance at ADA-info@lausd.net. 

mailto:ADA-info@lausd.net

